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ВЕКТОРНАЯ ГРАФИКА НА ПРИМЕРЕ  

СOREL DRAW X5 

 
ЛАБОРАТОРНАЯ РАБОТА N 1 

ИСПОЛЬЗОВАНИЕ МЕТОДОВ ПОСТРОЕНИЯ РИСУНКОВ И ИНСТРУМЕНТОВ 

В COREL DRAW. 

 

Цель работы: создать рисунок снеговика, используя набор 

инструментов рисования CorelDraw. 
Документы Corel Draw X5 состоят из отдельных элементов, 

называемых объектами. Граница объекта называется путем (Path). 

Путь бывает замкнутым или открытым.  
Заливку цветом можно применить к объекту только с 

замкнутым путем, а с открытым путем - нельзя. Путь формируется 

из узлов, которые пересекает граница объекта. 
Некоторые инструменты Corel Draw X5 автоматически создают 

объекты с замкнутым путем. Например, инструментом Ellipse Tool 

(Эллипс) можно рисовать овалы и окружности, инструментом 
Rectangle Tool (Прямоугольник) - квадраты и прямоугольники, а 

инструмент Polygon Tool (Многоугольник) позволяет 

воспроизводить многоугольники и звезды, инструмент Bezier Tool 
(Безье) предназначен для создания объектов, как с замкнутым, так и 

с открытым путем.  

Созданный рисунок можно сохранить в файле или распечатать, 
задав высокое разрешение. В режиме Print Preview 

(Предварительный просмотр) можно увидеть, как будет выглядеть 

каждая страница напечатанного документа. 

Выполнение работы: 

1. Запустите программу Corel Draw X5.  

Щелкните по кнопке Пуск (Start) на панели задач Windows и 
выполните команду Программы→ Corel Draw X5.  

2. Создайте новый документ. 

Выберите команду Новый из заставки либо выберите команду 
меню Файл → Новый, либо щелкните по значку  - Новый на 

панели инструментов, либо нажмите клавиши Ctrl+N.  

3. Сохраните открытый документ. 

 Выберите команду меню File → Save (Файл → Сохранить) 

или File → Save As (Файл → Сохранить как). 



 Откройте диск или папку, в которой нужно сохранить 

рисунок. 

 Введите название рисунка «Снеговик» в поле File Name 

(Имя файла). По умолчанию устанавливается тип файла CorelDraw 

(с расширением .cdr). Чтобы сохранить файл в другом формате, 

выберите нужный тип из списка Save as type (Сохранить как тип) 
в окне сохранения документа. 

 Нажмите кнопку Save (Сохранить). 

4. Создайте рисунок Снеговика для поздравительной 
открытки (Рис.1). 

 
Рис. 1 Интерфейс CorelDrawX5 

 

4.1. Постройте голову, тело и глаза Снеговика, используя 

инструмент Ellipse tool (Эллипс). 

 На панели инструментов Рисование выберите значок Ellipse tool 

(Эллипс) . Указатель примет форму крестика с 

присоединенным к нему крошечным эллипсом. 

 Щелкните левой клавишей мыши в любой точке окна и потащите 

указатель по диагонали. По мере перетаскивания появляется 

эллипс. 

 Чтобы завершить его рисование, отпустите клавишу мыши. 

Эллипс будет выделен, при этом вверху его показан один узел, 

а вокруг него - восемь маркеров. 
Чтобы нарисовать окружность, нажмите клавишу Ctrl при 

перетаскивании указателя. При этом сначала нужно отпустить мышь, 

а уж затем клавишу Ctrl. 

4.2. Выделите объекты: 

4.2.1. Выделите один объект 



 На панели инструментов выберите Pick Tool (Указатель) . 

 Щелкните по объекту, который нужно выделить. Вокруг него 

появятся восемь маркеров. 

4.2.2. Выделите несколько объектов 

 На панели инструментов выберите Pick Tool (Указатель) 

. 

 Удерживая нажатой клавишу Shift, щелкните по каждому из 

объектов, которые нужно выделить. По мере выбора 

дополнительных объектов маркеры будут охватывать все 

большую область рисунка, окружая все выделенные объекты. 

 Отпустите клавишу мыши, когда маркировка охватит все 

объекты. Группа элементов будет выделена маркерами, как 
один объект. 

4.2.3. Выделите все объекты на странице: 

Выполните команду меню Edit→ Select All & Objects (Правка 
→ Выделить все → Объекты), либо нажмите Ctrl+A, либо дважды 

щелкните по значку Pick Tool . 

4.3. Передвиньте объекты. 

4.3.1. Переместите объекты методом перетаскивания: 

 щелкните по объекту инструментом Pick Tool (Указатель) 

и, удерживая нажатой левую клавишу мыши, перетащите 
объект в нужное положение; 

4.3.2. Переместите объекты путем сдвига: 

 Выделите объект инструментом Pick Tool (Указатель). 

 Нажимайте клавиши перемещения курсора, чтобы 

переместить объект на расстояние, равное заранее 
установленному сдвигу. Чтобы передвинуть объект на 

расстояние, равное некоторой доле установленного сдвига, 

удерживайте нажатой клавишу Ctrl, работая клавишами 
перемещения курсора. Чтобы передвинуть объект на 

расстояние, равное нескольким сдвигам, удерживайте 

нажатой клавишу Shift, работая клавишами перемещения 
курсора. 

4.3.3. Переместите объект методом задания новых 

координат: 

 Выделите объект инструментом Pick Tool (Указатель). 



 На панели свойств введите значения для X 

(горизонтальной) и Y (вертикальной) координат. Эти 

координаты задают положение центра объекта. Нажмите 

клавишу Enter. 
4.4.Залейте построенные объекты. 

Заливка объекта сплошным цветом, называемая однородной. 

Однако прежде чем заливать объект, необходимо добиться, чтобы 
его контур был замкнутым. 

4.4.1.Залейте замкнутую фигуру однородной заливкой. 

 Выделите один или более замкнутых объектов. 

 Щелкните по цвету в любой открытой палитре в правой 

стороне окна или используйте инструмент  
Однородная заливка на панели инструментов. 

4. 4.2. Залейте объекты градиентной заливкой: 

Градиентную заливку можно создавать с помощью 
следующих инструментов: 

• Fill Tool (Заливка) - Fountain Fill Dialog (Градиентная 

заливка), где заливка создается на основе параметров, 

установленных в диалоговом окне;  

• Interactive Fill Tool (Интерактивная заливка), где 

заливка создается путем выбора параметров на панели свойств и 
манипуляций мышью с объектом. 

Для создания градиентной заливки с помощью диалогового 

окна Fountain Fill: 

 Выделите объект с замкнутым путем. 

 Из раскрывающейся панели Fill вызовите диалоговое окно 

Fountain Fill (Градиентная заливка) или нажмите клавишу 

F11). 

 В появившемся диалоговом окне выберите тип заливки из 

списка Туре (Тип). 

 Установите другие параметры, такие как начальный 

(раскрывающаяся палитра From (От)) и конечный 

(раскрывающаяся палитра То (До)) цвета, Angle (Угол) и 

Mid-Point (Центральная точка). 
 Нажмите ОК. Градиентная заливка будет применена к 

объекту. 



4. 4.3. Заполните объекты узором: 

Для создания заливки узором с помощью диалогового окна 
Pattern Fill: 

 Выделите объект с замкнутым путем. 

 Из раскрывающейся панели Fill вызовите диалоговое окно 

Pattern Fill (Заливка узором). 

 
Рис.2 Окно заливки узором 

 В появившемся диалоговом окне (Рис.2) выберите тип 

заливки: 2-цветный, полноцветный или растровый. 

 Из раскрывшегося окна с изображениями узоров выберите 

нужный узор и нажмите кнопку ОК. Градиентная заливка 

будет применена к объекту. 
4. 4.4. Заполните объекты текстурной заливкой: 

Чтобы залить объект текстурной заливкой, воспользуйтесь 

диалоговым окном Texture Fill: 

 Выделите объект с замкнутым путем. 

 Из раскрывающейся панели Fill вызовите диалоговое окно 

Texture Fill (Заливка текстурами). 

 
Рис.3 Диалоговое окно заливки текстурами 



 В появившемся диалоговом окне (Рис.3) из списка текстур 

выберите нужную текстуру. 

 Справа окна можно поменять цвета, входящие в данную 

текстуру и просмотреть полученный вариант текстуры, 

нажав на кнопку Просмотр. 

 Нажмите кнопку ОК. Объект зальется выбранной 

текстурой. 

4.5.Измените цвет контура выделенного объекта 

 щелкните правой клавишей мыши по цвету в палитре 

справа окна либо используйте инструмент Абрис  на 

панели инструментов. Откроется окно Перо Абриса 

(Рис.4), в котором можно задать цвет, ширину и стиль 
контура объекта. 

 
Рис.4 Окно Перо Абриса 

Чтобы удалить контур объекта, щелкните правой клавишей 

мыши по квадратику со значком X в палитре справа окна. 
4.6.Скопируйте овал глаза.  

 Выделите объект, который нужно скопировать. 

 Выберите команду меню Edit→Сору (Правка → 

Копировать) или нажмите клавиши –Ctrl+C.  

 Объект будет добавлен в Буфер обмена. 

 Выполните команду меню Edit → Paste (Правка → 

Вставить) или нажмите клавиши Ctrl+V.  

 Можно также применить метод копирования 

«перетащить и оставить». Для этого перетащите 
выделенный объект инструментом Указатель, 

придерживая клавишу «+» клавиатуры. 

Копия объекта появится в рисунке. 
4.7. Постройте ведро на голове Снеговика путем построения 

прямоугольника с закругленными верхними углами. 

4.7.1. Постройте прямоугольник (заготовка ведра): 



 Выберите инструмент Rectangle Tool 

(Прямоугольник) на панели инструментов или 

нажмите F6. Указатель мыши примет форму крестика с 

присоединенным к нему крошечным прямоугольником. 

 Щелкните левой клавишей мыши в любой точке окна и 

потащите указатель по диагонали. По мере 
перетаскивания появляется прямоугольник. 

 Завершите рисование, отпустив клавишу мыши. 

Прямоугольник будет выделен, при этом в четырех его 
углах показаны узлы, а вокруг него восемь маркеров. Для 

изменения размеров прямоугольника используйте его 

маркеры. 
 

4.7.2. Закруглите углы прямоугольника. 

После того как прямоугольник нарисован, можно закруглить 
его углы. Эта операция выполняется для всех углов сразу или 

только для нескольких из них. Углы могут быть слегка 
закругленными, создавая эффект смягчения, или сильно 

закругленными, практически превращая прямоугольник в овал. 

Для закругления углов прямоугольника: 

 На панели инструментов из дополнительной панели 

инструментов ShapeTool (Форма) выберите значок 

ShapeTool или нажмите клавишу F10. 

 Выберите прямоугольник, углы которого нужно 

закруглить. Вокруг него появятся четыре черных узла.  

 Чтобы одинаково закруглить все углы, выделите сразу все 

узлы, а затем курсором мыши скруглите их; 

 Чтобы закруглить только отдельные углы, выделите 

только нужные узлы, удерживая нажатой клавишу Shift, 

а затем курсором мыши скруглите нужный угол. 
4.8. Постройте нос, ноги и звезды вокруг Снеговика, используя 

панель инструментов  

Постройте многоугольники и звезды. 
4.8.1. Создайте многоугольник: 

 Выберите инструмент Polygon Tool (Многоугольник) 

(Рис.4) на панели инструментов. Указатель мыши примет вид 

крестика с присоединенным к нему крошечным многоугольником. 

 На панели свойств щелкните по значку Polygon 

(Многоугольник) и в текстовом поле Number of Points On Polygon 



(Количество вершин многоугольника) укажите количество его 

вершин. 

 Щелкните в окне рисования и потяните указатель мыши 

по диагонали. Отпустите клавишу мыши – многоугольник построен. 
По периметру выделенного объекта появятся узлы. 

4.8.2. Нарисуйте звезду:  

 Выберите инструмент Polygon Tool (Многоугольник)  

Star (Звезда), либо Polygon Tool (Многоугольник) Complex 

Star (Сложная звезда) (Рис.4). Указатель мыши примет вид 

крестика с присоединенной к нему крошечной звездой. 

 
Рис.4. Панель инструментов Polygon Tool (Многоугольник) 

 

 На панели свойств укажите количество вершин звезды. 

 В окне рисования потяните указателем мыши по 

диагонали. Отпустите клавишу мыши – простая или сложная звезда 

построена. 
4.9. Постройте рот и руки Снеговика, используя панель 

инструментов Freehand Tool (Рисование) (Рис.5) 

 
Рис 5 Панель инструментов Freehand Tool (Рисование) 

 

4.9.1. Нарисуйте прямую линию: 

 Выберите инструмент (Прямая)  . Указатель примет 

форму крестика с присоединенной к нему крошечной волной. 

 

 



 Щелкните по точке, откуда должна начаться прямая, а 

затем там, где будет располагаться ее конец. 

4.9.2. Нарисуйте кривую линию: 

 Выберите инструмент Freehand . Указатель примет 
форму крестика с присоединенной к нему крошечной волной. 

 Щелкните мышью в исходной точке и, не отпуская 

клавишу мыши, нарисуйте кривую. 

 Отпустите клавишу, когда линия будет закончена. 

CorelDraw сгладит нарисованную кривую. Вдоль пути появится 
несколько узлов. 

Чтобы стереть часть линии, нажмите и удерживайте нажатой 

клавишу Shift потащите инструмент Freehand Tool обратно вдоль 
нарисованной кривой. По мере передвижения курсора линия 

стирается. 

4.9.3. Нарисуйте ломанную линию, используя инструмент 

Bezier Tool (Кривая Безье)  

 Для создания ломанной линии выберите инструмент 

Bezier Tool. Указатель примет форму крестика с 

присоединенной к нему крошечной кривой. 

 Щелкните по точке, где будет располагаться первый 

узел, затем щелкните там, где будет находиться следующий 

узел. Между двумя узлами появится участок прямой линии и 
т.д. до получения ломанной линии нужной длины. 

 Когда рисование будет закончено, нажмите клавишу 

пробела или выберите другой инструмент. 

 

4.9.4. Отразите объекты 
Объект можно отражать вертикально, горизонтально или в 

обоих направлениях. Эта операция выполняется путем перетаскивания 

центрального маркера либо с использованием инструментов панели 
свойств. 

 Для отражения объекта выделите объект. Вокруг него 

появятся восемь черных маркеров.  

 Для горизонтального отражения объекта при нажатой 

клавише Ctrl, перетаскивайте левый или правый 
центральный маркер в противоположном направлении. 



(Правый маркер - влево, левый - вправо), либо на панели 

свойств нажмите на кнопку Горизонтальное отражение  

. 

 Для вертикального отражения объекта при нажатой 

клавише Ctrl  перетаскивайте нижний или верхний 

центральный маркер в противоположном направлении 

(верхний маркер - вниз, нижний -вверх) либо на панели 
свойств нажмите на кнопку вертикальное отражение 

. 

 

4.9.5. Сгруппируйте и разгруппируйте объекты . 

Группировка связывает объекты таким образом, что ими можно 
манипулировать как единым целым. Например, если нужно переместить 

несколько объектов, не меняя при этом их взаимное расположение, 

можно сгруппировать их, а затем переместить как целое. 
Форматирование, применяемое к группе, также влияет на все ее 

объекты. Если в дальнейшем понадобится работать с отдельными 

объектами группы, следует их разгруппировать. 
Для группирования объектов: 

 Используя инструмент Pick Tool (Указатель), выделите два 

или более объекта, растянув вокруг них пунктирный прямоугольник, 

или, щелкая по ним мышью при нажатой клавише SHIFT; 

 Выполните команду меню Arrange → Group (Упорядочить 

→ Сгруппировать). 

При последующем выделении объектов маркеры появятся вокруг 

всей группы, а не каждого объекта в отдельности. 
Для разгруппирования объектов: 

 Используя инструмент Pick Tool, выделите сгруппированные 

объекты. 

 Выполните команду меню Arrange → Ungroup 

(Упорядочить → Разгруппировать). 

 

4.10.Постройте метлу Снеговика с использованием эффекта 
перетекания объектов. 

Перетекание - это операция, в результате которой создается 

определенное количество промежуточных объектов (или шагов) 
между двумя выделенными объектами. Перетекание можно 



использовать для быстрого создания многочисленных копий одного 

и того же объекта либо для соединения двух объектов и создания их 
гибрида. Соединив перетекания, можно получить множественное 

перетекание, которое применяется для создания подсветки и 

сверкающих объектов. 

Для перетекания объектов: 

 Нарисуйте два объекта, которые будут перетекать друг в 

друга (например, два прямоугольника – Рис.2а). 

 Залейте их градиентной заливкой. 

 На панели инструментов выберите инструмент Interactive 

BlendTool (Итерактивное перетекание) , щелкните по 

первому объекту и протяните указатель к центру второго объекта. 

Появится пунктирная линия с белыми квадратиками на концах, 

отпустите клавишу мыши. Между двумя объектами появятся 
промежуточные.  

 

. 
 

 

 
 

а)    б)   в)   г)  

 д) 
Рис. 2. Пример перетекания объектов. 

 

 На панели инструментов выберите инструмент 

Интерактивная оболочка , соберите точки 

верхушки метлы в один узел (Рис.2в). 

 Постройте прямоугольник, залейте его и поверните на 

угол 200  (угол поворота задается на панели свойств) 

(Рис.2г). 

 Соедините палку с метелкой и сгруппируйте объекты 

(Рис.2д).. 

 Вставьте метлу в руку Снеговика и сгруппируйте весь 

рисунок. 

 

4.11. Добавьте и отформатируйте текст на открытке. Текст 

Итерактивное 

перетекание 

 
 

  
 



в CorelDraw можно использовать в виде блока текста, перемещать из 

одного блока в другой, вписывать в замкнутый объект (например, 
окружность или звезду), помещать вдоль пути открытого или 

закрытого объекта (например, вдоль кривой или овала) или добиться, 

чтобы он обтекал некоторый объект. 
 

4.11.1 Добавьте блок текста в документ. 

 Выберите инструмент Text Tool  или нажмите 
клавишу F8. 

 Щелкните в той точке, где нужно поместить начало 

текста и, не отпуская клавиши мыши, потащите указатель по 
диагонали, чтобы создать текстовую рамку. Отпустите клавишу 

- внутри рамки появится I- образный курсор. Наберите текст.  

 

4.11.2. Преобразуйте обычный текст в художественный: 

 Выделите обычный текст инструментом Pick Tool 

(Указатель) . 

 Выполните команду меню Text →То Artistic Text (Текст 

→ Преобразовать в фигурный) или нажмите клавиши Ctrl+F8. 
Рамка вокруг текста пропадет, а восемь черных маркеров останутся, 

они позволят работать с текстом, как с объектом, например, изменять 

его размеры.  

 Можно также произвести обратное превращение 

фигурного текста в обычный. Для этого выделите фигурный текст 

инструментом Pick Tool (Указатель)  и выполните команду меню 
Text Convert То Paragraph Text (Текст → Преобразовать в 

обычный) или нажмите клавиши Ctrl+F8. Вокруг текста появится 

рамка. 
4.11.3 При желании измените содержание текста 

поздравительной открытки. 

Для редактирования текста выполните команду меню Text→ 

Edit Text (Текст → Редактировать текст) или нажмите клавиши 

Ctrl+Sift+F8 Появится диалоговое окно Edit Text (Редактирование 

текста). Отредактируйте текст в окне и нажмите ОК. 
 

4.11.4. Отформатируйте текст. 



а) Чтобы отформатировать текстовый блок, выделите его 

инструментом PickTool (Указатель) , а затем на панели 

свойств, нажмите на кнопку , или выполните команду из 
меню Text → Format Text (Текст → Форматирование 

символов), или нажмите комбинацию клавиш клавиатуры 

Ctrl+Т. Справа экрана появится окно Форматирование 

символов, позволяющее форматировать все выделенные 

символы и слова текстового блока. 

 
4.11.5. Поместите текст внутрь объекта или вдоль пути: 

 

Расположение текста вдоль пути состоит в привязке строки 
текста к пути объекта, при этом строка текста принимает форму 

линии этого пути. Такую операцию можно осуществить 

интерактивно или воспользоваться командой из меню Text (Текст). 
Для расположения вновь создаваемого текста вдоль пути: 

 Используя инструмент Pick Tool (Указатель), выделите 

объект, вдоль которого нужно расположить текст. Объект может 

быть как замкнутым, так и открытым (линией). 

 Поместите инструмент Text Tool (Текст) на путь объекта. 

Указатель примет вид I-образного указателя с присоединенной к 

нему буквой А~. 

 Щелкните мышью в той точке пути, куда нужно поместить 

текст. 

 Наберите текст. По мере ввода он будет располагаться 

вдоль контура объекта. 

 Выделите текст и выберите начертание и размер шрифта 

на панели свойств.  

Для размещения вдоль пути готового текста: 

 Создайте объект, вдоль которого должен располагаться 

текст. 

 Придумайте художественный текст, выберите шрифт, 

установите цвет, узор или текстуру. 

 Выделите оба объекта, либо, удерживая нажатой клавишу 

Shift, и щелкая по ним мышью, либо, растянув вокруг них 

пунктирный прямоугольник (маркировку) инструментом Pick Tool. 

 Выполните команду меню Text → FitText to Path (Текст 

→ Расположить вдоль пути), либо на панели инструментов 



нажмите кнопку Текст , поставьте курсор в виде А~   на контур и 

щелкните правой кнопкой мыши, текст будет направлен вдоль пути 
объекта. 
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